Chapter 20: Searching for Records and Patients

There are three search tools in SEER*DMS: Quick Search, Patient Lookup, and Data Search. Use
the Quick Search or Patient Lookup when you are looking for a specific patient’s data. Use the
Data Search to review a set of patient sets or records; or to create an extract file containing
patient set or record data fields.

e Quick Search — If your search is based on a single data field, enter the field’s value into
the Lookup box on the user bar. You may search for a patient’s data by entering a Patient
Set ID, Record ID, Import ID, patient name, date of birth, or SSN. The Quick Search also
provides a shortcut for opening an AFL, follow-back need or group, contact, facility, or
worklist task. It is a shortcut to the Data Search for searches based on Import ID or a list
of Patient Set or Record IDs.

e Patient Lookup — Use the Patient Lookup to search for a patient’s data based on multiple
search fields or to search on fields not supported by the Quick Search. You may enter
search values for standard patient identifiers such as name, SSN, date of birth, sex,
accession number, and medical record number.

e Data Search — The Data Search allows you to define robust search criteria based on any
record or patient set field, Import ID, Special Study ID, or type of worklist task. You may
search for a set of records or patient sets by entering a list of Patient Set/Record IDs. Use
the Data Search to assign patient sets or records to Quality Control tasks, to review unusual
data, or to create small ad hoc extract files.

Once you find the data of interest, you may view or edit the data in the record or patient set editor.
However, you must take precautions to ensure that you do not modify data that are being
processed by others. To avoid the loss of effort, you should verify that the data are not involved in
worklist tasks and are not being edited by another staff member (please refer to the Direct Editing
of Records and Patient Sets section of this chapter for more information).

In this chapter, you'll learn about

e Quick Search

e Patient Lookup

e Data Search

e Data Search Action Menu

e Creating SQL Data Searches

¢ Direct Editing of Records and Patient Sets

Quick Search

The Lookup search box on the SEER*DMS user bar allows you to do quick searches. It will only be
available if you have system permissions to view and/or edit patient data.

User: coyle Lookup: Li ] Account | Logoff

View r Manager System Help »

Enter the search text into the Lookup box and press Enter. If you enter a string consisting of all
digits, the search will assume that you are searching by Record or Patient Set ID. The search fields
supported by the Quick Search are listed below.

e Patient Set or Record ID. To open a patient set or record in the editor, simply enter the
ID into the Lookup box. The ID prefix is optional (PAT-12345678 or 12345678 will work).
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The patient set or record matching the ID will open automatically. To search for a set of
patient sets or records, enter a list of IDs separated by blanks or commas. The Data Search
will be opened and the ID filter will be set. The Data Search does not allow you to search
for patient sets and records at the same time, therefore, the first ID will determine whether
it is a record or patient set search.

Patient Name. You may enter “last name” or “last name, first name” into the Lookup box.
The Patient Lookup will open and display the results of your search.

Date of Birth. MM-DD-YYYY format is required. A valid month and year are required by
the Quick Search. You may enter 99 for unknown day. The Patient Lookup with be opened
with the results of your search. Patient Lookup results are limited to 100 matches.

Social Security Number. A complete SSN in the 99-99-9999 format is required. The
Patient Lookup will be opened with the results of your search.

Import ID. Enter an Import ID into the Lookup box to search for records in that import.
The IMP prefix is required. The Data Search will automatically open. The fields displayed
by default are determined by registry configuration settings. Data Search permissions are
required for searches by Import ID.

Worklist Task ID. Enter a single Worklist Task ID with the TSK prefix. The worklist will
automatically open and the worklist filters will be set to show the specified task.

AFL, Contact , Facility, or Follow-back Need ID — If you have the appropriate

permissions, you may open an AFL, Contact, Facility, or Follow-back Need by entering the
appropriate ID. The AFL, PER, FAC, or FBN prefix is required. This allows you to bypass
the manager when you wish to view a specific AFL, Contact, Facility or Follow-back Need.

AFL or Follow-back Group ID. Enter a single Follow-back or AFL Group ID (the FBG or
AFL prefix is required). The AFL or Follow-back Manager will automatically open and the
filters will be set to show the items in that group.

Click the information icon next to the Lookup box for a reminder of the search fields that are
supported.

20-2

User: coyle Lookup: - n
e ]

In this Lookup, vou can search by:

Patient Set ID

Record ID

Import ID (IMF)

SSM (NNM-NMN-NMMM, dashes required)
FPatient name: last name, first name
Patient last name

Full Date of Birth (MM-DD-YYYY)
Abstract Facility Lead (AFL)
Abstract Facility Lead Group (&FG)
Contact (PER)

Facility (FAC)

Follow-Back Need (FBN)
Follow-Back Group (FBG)

Worlkflow Task (TSK)
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Patient Lookup

The Patient Lookup can be accessed from the View menu or you can click the Lookup link in the
user toolbar. The Patient Lookup enables you to search for a patient’s data based on personal
identifiers (Name, DOB, SSN, Sex, Race, Accession Number, Medical Record Number). The Data
Type, Facility, and Exclude criteria can be used to limit the search to a subset of data.

Patient Lookup Viewr Managev Systemrw Help »
Name (L,F,M) | | | | | | Facility l:l';" Data Type |Patient Sets -
. Unlinked Records |2
o — accession ] il
s [ ] Medrec s [ ] Desth Cert
Death Notice
Sex |:EI Exclude | dead = 4 years ﬂ Follow-up Only
Follow-up T =
Race | [~] o R ans

Search Fields in the Patient Lookup

SEER*DMS uses registry-specific matching algorithms to compare the patient information specified
in the search fields to patient sets and unlinked records in the database. The Patient Lookup
matching algorithm is documented on the Matching help page in SEER*DMS.

A weighted matching scheme may be implemented in the registry-specific algorithm. In weighted
matching, a score calculated for each possible match provides a mechanism to sort the results by
the likelihood of the match. Entering multiple identifiers quickens the search and increases the
score of true matches. It is recommended that you enter information into as many fields as
possible or enter a unique identifier, such as Social Security Number. If searching for a patient
with a common name, it is particularly important to enter values into as many search fields as are
known. At a minimum, you must enter one of these fields; SSN, Last Name, DOB, Accession
Number, or Medical Record Number.

The Standard search fields are listed below.

¢ Name (L,F,M) — Three search fields are provided for searching by patient name. You may
enter a full or partial name in any or all of the boxes. The boxes are displayed in the order
of last name, first name, middle name. However, you may enter “Last, First” into the first
box. SEER*DMS will automatically parse the text into the two fields for the search.

¢ DOB - Enter date of birth in MMDDYYYY or MM-DD-YYYY format. If you only know the
patient’s year of birth, enter 99 for day and month (e.g., 99-99-1961). A valid month and
year are required when other patient identifiers are not specified (last name or social
security number).

e SSN — A complete Social Security Number must be entered. The value may be formatted
as 999999999 or 999-99-9999.

e SeXx — A drop-down list enables you to search for data based on a valid code for sex.

¢ Race — A drop-down list enables you to search for data based on a valid code for race. One
value for race may be selected.

e Accesion — A complete Accession Number must be entered. Accession Number is the
facility’s identifier for a CTC. A search by Facility ID and Accession Number should return a
single result. However, if you do not know the Facility ID or believe the facility may be
coded incorrectly then you should search only by Accession Number.

e Med Rec # — A complete Medical Record Number (MRN) must be entered. Medical Record
Number is the facility’s identifier for a patient. Two or more patients may have the same
Medical Record Number if those MRNs were assigned by different facilities. You have the
option of searching by Facility ID and MRN (one result should be returned); or you may
search by MRN without the facility, but multiple results may be returned.
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You must specify a value for at least one of these fields: last name, Social Security Number, Date
of Birth, Accession Number, or Medical Record Number. The Patient Lookup is designed to search
for data for a specific patient; you cannot use it to generate a generic list of data by sex, race,
record type, or facility. To create such a list, you should either use the Data Search, as described
later in this chapter, or query the database using an external tool.

Limiting the Search

You may specify the records and patient sets to be searched by entering values for facility, data
type, and the “exclude” field. Unlike the Search Fields, these criteria are never weighted. They are
used to make a definite determination of whether a record or patient set is “in” or “out” of the
search results.

e Facility — Limit the search to patient sets with admissions or treatments related to a
specific facility (this may be the reporting or treating facility), or to unlinked records that
were provided by the facility. Leave this field blank to search all data regardless of facility.

e Exclude — Exclude patient sets and records for patients who have been dead for more than
the specified number of years (based on vital status and date of last contact). Leave this
field blank to search all data regardless of vital status. The default setting for this field is
determined by a User Preference setting. To change the default, click the Account link in
the user toolbar (next to the Lookup search box).

e Data Type — Search all patient sets and unlinked records, or limit the search to one or
more data types. To include linked records in the search, you must include patient sets.
The patient set to which the record is linked will be returned. To select more than one data
type, hold down the CTRL key and click each desired type. To deselect a type, click it a
second time while holding the CTRL key.

Executing the Search in the Patient Lookup

Enter as much information as known into the form and click Search. As many as 100 matches will
be displayed. The results will be sorted by score with the best matches listed first. The results will
include records and/or patient sets which, according to your registry’s matching algorithms, yielded
a score greater than zero when matched using the search and exclusion criteria. To view the
algorithm, click the Patient Lookup link shown below the results table.

You may click an ID to open a record or patient set in an editor. If the data are involved in a
worklist task, a link will be displayed in the Tasks column. The link indicates the user who is
assignhed to the task or that the task is unassigned. Other data columns are described below.

To search for a new patient, click the Clear button. Patient information that you entered will be
removed, the Facility field will be cleared, and the Exclude field will be set to the system default.
The Data Type is retained to allow you to search for a specific data type for multiple patients.

Patient Lookup Search Results

The columns listed below are shown in the search matches. The value in the table will be shown in
bold if it is an exact match to a search field. If the matching algorithm supports partial matches for
Social Security Number and Date of Birth, only the matching fragment will be shown in bold. Fields
not listed may have been involved in the search. For example, the matching algorithm may
compare last name to maiden name or alias last name.

e Score — A value calculated by the matching algorithm that allows the results to be sorted
by the likelihood of the match. You may click the score to view a summary of the
calculation. Results with the highest score are displayed first.
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e Type — Data type. Patient Set or a record type will be listed. If the match is a record and
the record’s reportability status is something other than “reportable”, an icon will be
displayed:

Non-reportable

[] Auditable

Unknown (reportability flag not set; screening has not been completed)

Not applicable; the record type is not screened (e.g., supplemental records)
--- No icon is displayed if the record is reportable.

e ID — Patient Set or Record ID. Click the Information Icon next to the Record’s or Patient
Set’s ID to see a select set of fields. To browse all pages of the record or patient set, click
the Record’s or Patient Set’s ID.

e Last Name, First Name, M — Patient’s last, first, and middle name. If the text is an exact
match to search criteria, it will be shown in bold. If the name is too long to display, an
ellipsis will be shown at the end of the name (...).

e DOB — Date of birth.
e SSN — Social Security Number.
e Sex — Coded value for sex. Hold your mouse over the value to view text description.

e Race — Race indicated in the first race field of the patient set or record. Hold your mouse
over the value to view text description.

e DOLC — Date of last contact.
e VS — Vital status.

e Tasks — If the data are in a worklist task, a link will be displayed in the Tasks column. The
link will be “unassigned” or the username of the person to whom it is assigned.

Data Search

The Data Search can be accessed from the View menu. Use the Data Search if you are:
e |ooking for a set of records or patient sets that are similar in some way
e and/or you want to create an extract of data fields
e and/or you want to create QC Tasks for a set of data.

There are several system permissions that control access to the data search. Typically, coders
should be given access to Patient Set and Record data searches, but system permissions related to
exports and SQL searches should be assigned to a limited number of staff. The system
permissions related to data searches are described below.

e data_search_export — Create export files from listings created in the Data Search. This
permission is required to extract data from Patient Set, Record, or SQL searches.

e data_ search_filter_manager — Modify, delete, and assign saved searches (or filters) in the
Data Search. This gives the user access to all saved searches that they have the ability to
execute.

e data_search_pat — Create a Data Search to create a listing of patient sets. This permission
is also required to search for a set of patient sets by entering a list of patient set IDs into
the Lookup box in the toolbar.

e data_search_rec — Create a Data Search to create a listing of record. This permission is
also required to search for a set of records using the Lookup box in the toolbar.
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e data_search_run_sql — Execute SQL Data Searches. A user with this permission can run
SQL searches made available to their account. They cannot create SQL unless they also

have the data_search_write_sqgl permission.

They cannot gain access to a saved search

unless someone assigns it to their account; or they have the data_search_filter_manager

permission.

e data_search_write_sgl — Create SQL data searches. This provides read only access to all
data (patient data, staff productivity, etc.). This permission should be restricted to registry
managers, QC managers, and staff who write SQL for managers.

Search Type

In the Data Search, you must set the Search Type first because it will determine the type of fields
that are available in other search filters (as shown below). You can search for patient sets or
records separately; or you can use SQL to run a query against any table in the database.

Data Search

Data Search

I |~

| |~

[ apply || Reset | | save |

| apply || Reset | | save |

Data Search

| -]

| apply || Reset |

| Save |

Search Type
Is Pat

Distinct Results
Is Yes

Criteria

Worklist Task Type
Patient Set 1D
Special Study

Display Fields
displayld
sequencelumber
namelLast
nameFirst
namaMiddle

Order By
displayld Asc

Search Type
Is Rec

Distinct Results
Is Yes

Criteria

Worklist Task Type
Record ID

Import

Special Study

Display Fields
documentId
namelLast
nameFirst
nameMiddle
birthDateMonth

Order By
documentId Asc

Search Type
Is SOL

sQL

The Patient Set and Record
searches have nearly identical
filter sets. There is one
additional filter for Record
searches — the Import ID
filter.

SQL searches have just one
filter. You can paste SQL into
the SQL filter and review the
results in the system.
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Distinct Results

Data Search

€ Resuits |
| [~

| Apply || Reset |

| Save |

Search Type
Is Pat

Distinct Results =

Is ¥as \

Criteria

dateOfDiagnosisYyyy Is Great
And dateOfDiagnosisYyyy Is L

Worklist Task Type
Patient Set ID

Special Study

Display Fields
displayld
nameFirst
namelLast
Order By
displayld Asc

Distinct Results — if yes, each row in the
results will be unique.

If set to No, results may include duplicate rows.
Examples:

-- You search for CTCs diagnosed between
1973-2008

-- And you set your display fields to “Patient
Set ID” and “Name”

-- And so the criteria include a CTC-level field,
but display fields are all at the patient level.

If Distinct Results = No, you will get duplicates
for patients who have 2 or more diagnoses in
1973-2008. “PAT-12345678, John Doe” could
be listed twice.

Recommendation: Set Distinct Results to yes.
Only set it to no if the query is very slow and
you either know that your search cannot
include duplicate results; or you do not mind
having duplicates in your results.

Distinct Results will prevent you from having duplicates in your results.
the search criteria fields are at a more detailed level than the display fields.

It comes into play when
It is strongly

recommended that you set it to Yes, but setting it to No will speed up some complicated searches.

Before setting it to No, be sure that you understand that you may have duplicate rows in your
results. Review the example shown above. The criteria include a CTC-level field, year of
diagnosis, but the display fields are all at the patient level. As an example, John Doe and the
Patient Set ID will be listed twice if he had a prostate and a lung cancer diagnosis during those

years.

the result fields (you could include tumor record number, sequence number, or site).

If you do want a separate result for each cancer then you should include cancer fields in

If you only

want patient name and ID, set distinct to yes so that you only get one result per patient.
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Criteria

The criteria determine which patient sets or records are returned in the results. You can create a
fairly complex, multi-line statement. The lines are joined with conjunctions: “and”, “or”, “and
not”, “or not”; and you can enter parentheses when the Boolean logic requires it. Be sure to click

the OK button when you have completely defined the criteria.

Your search will return a result set based on the full criteria statement and-ed with all other filters.
For example, the result set for a Patient Set Search is determined as follows.

Patient Set Results = Criteria Statement + Worklist Task Filter + ID Filter + Special Study Filter.

Only use a filter to reduce a list. A filter should be cleared if you want all items regardless of that
filter's values. For example, do not select anything in the Worklist Task Type filter if you want all
data regardless of whether it is in the worklist.

Data Search

[2pply | [ Reset | [ save | Enter Criteria, Worklist Task Type, Patient Set ID or Special Study

Search Type
1s Pat

Distinct Results
Is Yes

Criteria L

delated 1= 0 N \
And dateOfLastContactYyyy 1=

And vitalStatus Ts 1 _cony | (| Fewd | _op | valke || |
And dalatad Is 0 Deleted (Patient) Is 1] edit | remove

L Em s e e And Date of Last Contact Year Iz Less 2009 edit | remove
Worklist Task Type And Wital Status Iz 1 edit | remove

_ And Deleted (CTC) Is 0 edit | remove

L o And Age at Diagnosis Is Less or Equal 19 edit | remove
Special Study And SEER Reportable Status Is 1 edit | remove
Fields And Not { Behavior ICD-0-3 (2001+) Is 2 edit | remove
displayld And Primary Site Starts With (FES ) edit | remove
tumorRecordMumber

seerRptableStatus

dateOfDiagnosisYyyy

primarySite
Order By Conj { Field Op Walue )

display1d Asc ana =[]l [FE— I [ade ]

The statement above will return Patient Sets that meet these criteria:
¢ Not deleted
e Date of Last Contact prior to 2009
e Vital Status = Alive
e And have at least one CTC that meets these criteria:
CTC is not deleted
Age at DX <= 19
SEER Reportable
Not cervix in situ

O O O o
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Using Auto-complete to Search for a Field

An auto-complete search is used to find fields for the Criteria, Display Fields, and Order By
features. There are several fields that are stored in different types of data. For example, last
name is a field in Patient Set Informants, Patient Set Aliases, and the Patient Set itself. Be careful
to verify the data entity when you select a field.

Data Search View » Manage » Tools» System » Help »

Actions > << Results m Show Query
| Apply | | Rezet | | Save ‘ Enter Criteria, Worklist Task Type, Patient Set ID or Special Study

Search Type
Is Pat

Distinct Results
Is Yes

Criteria

Worklist Task Type
Patient Set ID
Special Study

Display Fields .
displayld \
nameLast
e . Fields |

nameMiddle Display ID (Patient ID Number) [PAT] remove
birthDateMm

Order By
displayld Asc

name last
Name--Last (Patient Alias) [PAT]
Name--Last (Patient Informant) [PAT

Name--Last (Patient) [PAT]

Enter a question mark to view the lookup values for a field.

Data Search

Results | Filters 0
| El Enter Criteria, Worklist Task Type, Patient Set ID or Special Study

[ Apply | [ Reset | [ save |

Search Type
Is Pat

Distinct Results
Is Yes

Criteria —— )

Worklist Task Type \ N
Patient Set ID Conj ( Field Op Value )
Special Study

Display Fields
displayId
sequenceNumber
namelast
nameFirst
nameMiddle

Order By
displayld Asc

Conj ( Field Op Value ]
[ T+l ]IsEER Reportable Status [CTC] [1= =1 | [ add |
0 : Not SEER Reportable
A o

A
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Worklist Task Type

In a record search, the Worklist Task Type filter allows you to search for records that are the focus
of a worklist task. You would not use the Data Search just to find records in the worklist. You
should use the worklist for that. But you can use the Data Search to find records that meet other
criteria and are in the worklist; or records that meet some criteria but are not in the worklist.

This filter only considers the record that is the focus of the task. For example, records listed as
possible matches in Match-Consolidate are not considered by this filter. Records can be the focus
of these tasks:

e Consolidate or Consolidate FUP

e Match-Consolidate or Supplemental Match
e Path Screening or Screening

¢ QC Record

e Resolve Record Errors

e Review Special Studies

You can search for “Is Missing” to find records that are not in the workflow. You can search for “Is
Not Missing” to search for records that are in any type of task.

In a Patient Set search, the Worklist Task Type filter allows you search for Patient Sets that meet
other search criteria and are in the worklist; or you can use this filter to exclude patient sets that
are in the worklist. It is important to understand that there are only a few patient set tasks
(Review Data, Resolve Patient Set Errors, Visual Edit Patient Set, and QC Patient Set). You cannot
use this filter to search for patient sets that are possible matches in match-consolidate; or are
currently involved in a consolidate task. The incoming record is the focus of those types of tasks.
One common use of this filter in a Patient Set Search would be to search for Patient Sets that are
failing an edit but are not in Resolve Patient Set Errors tasks. (To search for Records or Patient
Sets with a particular edit, set the Criteria to Edit Rule ID is <Edit ID>.)

ID Filter

Data Search
Results | Filters [

| 2pply || Reset | | Save |  Enter Criteris, Worklist Task Type, Patient Set ID or Special Study

Search Type
Is Pat

Distinct Results
Is ¥es

Criteria
Worklist Task Type
Patient Set ID T

Special Study

Display Fields Ranges supported

displayld Is Not

namelast % Starts With o
nameaFirst Regex

nameMiddle

birthDateMm

Order By

displayld Asc
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Use the ID Filter to search for patient sets or records by ID.

e You can search for a single ID or paste a long list of IDs into the filter. Each ID in a list
must be separated by a blank or a comma.

e The PAT- and REC- prefixes are optional.
e Use “Is Not” to exclude certain patient sets or records from your search.
e The results of the ID filter will be “and-ed” with the Criteria statement and the other filters.

Special Study Filter
Use the Special Study Filter to search for patient sets or records by study.

e You can search for records or patient sets that are in a certain special study.
e Or use “is not” to search for data that are not in a specific study.
e Or search for data not in any study (use the Missing option).

Import ID Filter

Use the Import filter to search for records loaded in a specific import. This filter is only available
when Search Type is set to Records. All imports are listed when you first click Import. Use the
search box at the bottom to find the Import ID. The search text will be matched against Import
ID, File Type, Username, and Facility ID.

Complete the filter statement of “Import <is or is not> Import ID”. To do this, you may enter an
Import ID into the text box at the top; or check the box next to the import in the search list. You
may enter a set of IDs or even a range of IDs.

Data Search
Results | Filters [

| Apply | | Reset | | Save | Enter Criteria, Worklist Task Type, Record ID, Import or Special Study

Search Type
Is Rec
Distinct Results

Is Yes

Criteria

Worklist Task Type

Record ID

Import P

Special Study [1= [«] [1MP-1028 |

Display Fields m m e

documentId

neOrDisgnosisYaar n“mmm_
lprémalry'hsrite [7] IMP-1030 06-24-2011 FAC-D067 coyle NAACCR 12.1 Full Abstract [UT]
aterall

I% IMP-1026 06-24-2011 FAC-1000 coyle 220 NAACCR 12.1 Full Abstract [UT]

Order By
documentld Asc

[abstract || search |
h s
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Display Fields

The Display Fields option defines the columns shown in the results table. You can specify the order
of the columns by moving the fields up or down in the list. The default list of Display Fields is
defined in the registry configuration; some registries only include patient level demographic fields
in the default set while other registries include tumor-level fields.

To change the order of the fields, grab the field with your cursor and move it up or down in the list.
A field is highlighted when it is selected, as shown below.

Data Search
Results | Filters [

| Apply | | Reset | | Save | Enter Criteria, Worklist Task Type, Patient Set ID or Special Study

Search Type
Is Pat

Distinct Results
Is Yes

Criteria

Worklist Task Type
Patient Set ID
Special Study

Display Fields o
displayld

namelast

nameFirst - Feds |5

nameMiddle Display ID (Patient ID Number) [PAT] remove

FrEEEE Name--Last (Patient) [PAT] remove

C.h.r.der By Name-—Fi_rst (Patierjt) [PAT] remove

displayld Asc Name--Middle (Patient) [PAT] remaove L
Birth Date Month [PAT] remove |~
Birth Date Day [PAT] remove
Birth Date Year [PAT] remaove
Social Security Number (Patient) [PAT] i remove
Sex [PAT] remove
Race 1 [FAT] remove
Date of Last Contact Month [PAT] remaove
[ |

\ o

Order By

Use Order By to define the sort order of the results. The default sort order is Patient Set or Record
ID in ascending order. You may specify multiple sort fields and you may specify ascending or
descending for each. You results can only be sorted by fields that are listed as Display Fields. Use
the auto-complete search box to find a field. Click Ascending to toggle to Descending and vice
versa. Once a list is created, you may grab a field to move it up or down in the list.

Display Fields

displayld
Last
:::EF,E;JC tumor record numberd
nameMiddle umor Record Number (CTC Reference ID) [CTC
birthDateMm Tumor Record Number (CTC) [CTL!

Order By
displayld Asc
Show Query

To view the source code used for the search, click the Show Query link in the upper right of the
results table. For Patient Set and Record searches, a summary of the specifications will be shown.
This provides a convenient way to debug a search that is returning unexpected results.
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Results Filters Hide Query

Distinct: Yes

Criteria: patient.ctcs.dateOfDiagnosisYyyy Is Greater 2003
And patient.ctcs.primarySite Starts With C50

Fields: patient.displayld, patient.ctcs.sequenceMumber, patient.namelast, patient.nameFirst, patient.nameMiddle,
patient.birthDateMm, patient.birthDateDd, patient.birthDateYyyy, patient.socialSecurityMumber, patient.sex, patient.racel,
patient.dateOfLastContactMm, patient.dateOfLastContactDd, patient.dateQfLastContactYyyy, patient.vitalStatus

Order By: patient.displayld Asc

If it is an SQL search, the SQL code is shown:

Results Filters Hide Query

SQL: SELECT (SELECT p.display_id FROM patient p WHERE p.pat_id = ev.pat_id) AS display_id,

(SELECT di.property_name FROM data_item di WHERE di.data_item_id = el.data_item_id) AS property_name,
old_wvalue,
new_value,
path

FROM pat_acd_element el JOIN pat_acd_event ev ON el.pat_acd_id = ev.pat_acd_id

WHERE ev.module_id = 12 AND ev.comments LIKE '%IMP-1002%' -- ****¥ Change this Import [D ¥***

and path = 'Address 2'

order by display_id, property_name

Reviewing Results in the Data Search

The data returned by your search will be displayed in the Results section of the screen.

Data Search Viewr Manage Tools» System » Help»
7 Results | Filters | Show Query
[EBreast (2004+) [=] 27,277 items, displaying 1 to 40. [First/Prev] 1, 2, 3, 4, 5, &, 7, 8 [Next/Last]
[ ooy | [ reset ] [ 5ove | displayId histologyICDO3 | behaviorICDO3 | vitalStatus | sex | racel | dateOfLastC|B|
by PAT-00005692 () | 03 c504 8500 3 1 201
Search Type PAT-00035967 () 00 c504 8523 3 1202
Is Pat PAT-00081083 (D | 00 €509 8010 3 4 201
Distinct Results PAT-00094252 () 02 C509 8520 3 4 7|01
Is Yes PAT-00117805 (1) | 02 €509 8500 3 1 201
Criteria PAT-00125493 (D) 00 €509 8010 3 4 201
dateOfDiagnosisYyyy Is Greah PAT-00150198 (i |02 C504 8211 3 1 2|01
And primarySite Starts With C! PAT-00176248 (1) 02 c504 8500 3 1 201 =

e The total number of results is shown at the top of the Results tab.
e 40 results are displayed per page. There are page controls on the right side of the screen.
e You may open a Record or Patient Set by clicking its ID.

e Click the double arrow next to the word Results to hide the filter panel and expand the
width of the results table. Click it again to re-open the filter panel.

Data Search Action Menu
The Actions associated with the Data Search are:

e Save Filter — If you frequently search for the same type of data, you do not need to
redefine your search each time. Saved searches are available in the drop-down list and
Filters tab. All users can see saved searches that they created and searches made available
to them by another user. Users with the data_search_filter_manager permission can access
all saved searches. A data search manager can create searches for others to use and
provide technical support to users who have saved searches.

e Delete Filter — Use this to remove the current search.

¢ Create QC Tasks — A QC Task can be created for each record or patient set in the results.
You will be prompted to provide instructions for the coders who complete the tasks. You
will be able to assign the tasks to another user, assign them to your own account, or leave
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the user field blank to create unassigned tasks. If appropriate, you can set a worklist flag
and/or assign a name to the QC project.

[~ =
As=ign to | El
Flag | IEI
Project Name | |

Instructions

b -

e Export — Use the Export option to create a text file containing all rows and columns in the
results. This option is only available to users with the data_search_export permission. The
export file will be a Comma Separated Values (CSV) text file, this is a common file format
that can be opened in Excel and other spreadsheet applications.

e Help — Select Help to review the Data Search tutorial (PDF). The tutorial is available in an
interactive format online at seer.cancer.gov/seerdms/manual.

SQL Data Searches

The data_search_write_sql permission is required to create SQL Data Searches. This permission
should be restricted to advanced users who have experience writing SQL queries. All SQL should
be written and tested in an external application like SQL Workbench before being used within
SEER*DMS. Test the query against the data warehouse and then copy it into the SQL text box.

Data Search

Actions > m Results Filters
| El Click the 5QL link on the left and define a query
[ Apply | [ Reset | [ save |

Search Type
Is SQL

SQL

' g

SELECT (SELECT p.display id FROM patient p WHERE p.pat_id = ey.pat_id) AS display id,
(SELECT dji.property name FROM data_item di WHERE di.data item id = egl.data_item id) AS property name,
old_v{lue,
new_value,
path
FROM pat_acd element el JOIN pat acd event ey ON el.pat acd id = ey.pat_aed id
WHERE gy.module id = 12 AND ev.comments LIKE *%IMP-1002%" == **ddd Change this Import ID ****
and path = 'Address 2°'
order by display id, property_name

€ o

The data_search_run_sqgl permission allows users to execute SQL Data Searches made available to
their account. They may have written the SQL data search or it may have been written by
someone else and made available to their account, all users, or users with their role. This screen
shot shows 3 SQL searches listed on the Data Search Filters tab. All were created by the same
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user. The first can be executed by all users with the data_search_run_sqgl permission. The second
search can be executed by users with the Passive Follow-up role who have the run SQL permission.
The third can only be executed by the user who created the search.

(€70 esutts | ilters

[all Filters  [+][30L |[ search |[ reset |

3 items.

@ teme - AvailobleTo |Creslcd By 5| Modificd By o| Modificd 2| Description ]

[] Autc-cons Changes - Address Added All Users coyle coyle 06-25-2011 SQL search to show patient sets
where an address was added by
the supplemental import
(Voters).

[] Auto-cons Changes - Voters Passive FollowUp coyle coyle 06-25-2011 This 3QL lists audit log entries of

changes made by IMP-1002
(10,000 Voter Records)

[7] Autc-cons Changes SS5A coyle coyle coyle 06-25-2011 This SQL lists audit log entries of
changes made by IMP-1006
(79,733 SSA Records)

Direct Editing of Records and Patient Sets

Requires system permission: pat_edit, pat_edit _demographics, pat_read_only, rec_edit, or
rec_read_only

SEER*DMS enables users to edit records or patient sets accessed via the Patient Lookup or Data
Search. Your read/write access to data is not restricted to workflow tasks. This creates the
possibility that two users may open the same record or patient set simultaneously. It is also
possible for you to open a record or patient set that is currently being processed in an automatic
task, or that is involved in a manual task. Prior to editing data that you access via the Patient
Lookup or Data Search, please review the information below and follow the appropriate steps to
avoid having your or another user’s changes overwritten.

If you attempt to modify data that has been modified by another user or process:

Two users may open and edit the same record or patient set. If this happens simultaneously,
the first person to attempt to save the data will be able to successfully save their changes. If
the other person attempts to save changes, SEER*DMS will display an error message indicating
that the record or patient set has been modified since the data were opened in the editor.
SEER*DMS will post an error message with instructions:

e Error: These data have been modified by another person or process; your changes cannot
be saved. Print the data if you need a listing of your current values. Reload the data by
selecting Undo Changes from the menu. You should review the revision history in the audit
log prior to re-entering and saving your edits.

e The same message will be displayed if the data were modified by a process after you
opened the editor but before you saved the data. In either situation, you should review the
audit log to determine which user or process modified the data and what changes were
made. You may continue editing, if appropriate.

If you attempt to modify data involved in a worklist task:

You may modify a patient set or record that is in a workflow task. For some tasks, there is no
conflict and your work may complete the task. For example, you open a patient set via the
data search and that patient set is in a Resolve Patient Set Errors task. No warning will be
displayed in the editor because there is no potential conflict. If you clear all edits and save the
task, the worklist task will be completed and the patient set will exit the workflow.
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However, there could be a conflict if you edit a record that is in a Consolidate task. You should
either open the task and make the appropriate changes to the patient set and/or record; or
contact the person to who the task is assigned.

If there is a potential conflict with a task, an Alert will be posted in the record or patient set
editor. SEER*DMS will post a warning message and provide a link to review the task. Itis
generally recommended that you access and edit data in the context of the pending task. You
should certainly review the task prior to making changes, to ensure that you and another staff
member are not duplicating efforts or editing the same data simultaneously.

[ | Alertsf@) | Text | Edits | )
Review Related Worklist Tasks (1)
Sourcel| _ Type | User | Task |
Record | Consolidate schusslern TSK-5590217 (0
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